Eris Data and Documentation System Testing and User Guide


E. R. I. S TM
E.R.I.S TM   is a Customer Based Data and Documentation Management system which is specially designed for service oriented business. It incorporates custom applications and business systems thus providing features such as Project Management, Customer Management, and File management. It stores data logically and can be easily retrieved by Customer or by Project.
Eris provides flexibility to users by integrating with Microsoft Office and other common applications. It is a complete Document Management system where multiple users can manage and have secure access to all of the files that they work on a daily basis.
Installation Procedure
Prerequisites for Eris Installer:

· .Net Framework 2.0

· SQL Server 2005 Express Edition
· Windows Installer 3.1
If above listed prerequisites are not installed on your machine then Eris Installer will install them for you.

Steps to Install Eris:

1. Insert the CD and double click the Setup file.

2. Welcome to the Eris Document Management system setup wizard will open,

Click next
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3. Select the installation folder
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      4.   Confirm Installation window will open. Click Next to start the installation.
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      5.   Installing Eris Document Management System window will open.
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6. Installation Complete window will open. Click Close to exit the window.
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Steps to Uninstall Eris:
You can uninstall Eris by using different methods.
1. Through control panel

· Go to Control Panel

· Click on Add/Remove Programs

· Select Eris Document Management System and Click on Remove.

This will successfully uninstall Eris Document Management System from your machine.

2. Through  Eris Document Management System (Windows Installer Package)
· Right click on Eris Document Management System. msi file(Windows Installer Package)

· Click on Uninstall

This will successfully uninstall Eris from your machine.

Open Eris
1. Go to Start ( All Programs ( Eris and Click on Eris.

2. Trial Notification window will open, click OK

3. The below window will open.
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4. The default Username is admin and Password is admin.

5. Enter the password and then click on Login
Note: This is a trial version. Eris may be registered for a 1year subscription or lifetime license based on the product key.

Steps for Registering 
1. Click on the Register Now button as shown in the above figure
2. The window in the figure below will open.
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3. Enter the User Name, Initials, Organization, and finally enter the 40 digit Product Key provided to you upon purchase.  Click OK

4. You are now registered using Eris.
Note: 

You can also register from the About tab within Eris.

Go to Help Menu

Click on About...

Click on Product Register; Repeat the above steps from 3 to 5

After registering, the Login Form will only request the User Name and Password without referencing registration.
Security Setup Procedure

As the Administrator, you will have to add Users and Groups to the Eris Data and Documentation System.  Only Administrators have access to add, edit and delete Users and Groups.  Groups and Users are used to control access to various Client / Project / Contact Information and Files associated with the Projects that are stored in the Eris System.  For example, you could setup a Group called Project Schedule Authors and another for Project Schedule Viewers.  The Security Items would then be setup to allow the Authors to create, open and update Project Schedules, whereas the Viewers could only view the Project Schedules.  All other users with their Item Security set to No Access would prevent them from opening the Project Schedules.
The advantage to using Groups and Users when defining Security Items is that once a Group is created with many Users, you only have to add the Group to the Security Item.  This saves you from having to add individual Users over and over again to different Security Items that will have similar sets of Users.

The first steps for setting up secured access are to add new Users to the Eris System.  This is done by working through the following procedure.
Add User
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1. Go to Tools menu

2. Click On Security

3. Click on  Users 

4. Click on Add User

5. Enter User Name, Password, Confirm the Password, First Name, Last Name, Street Address, Phone Number and Email Address
6. Click on Save to Save New User

7. Click on Cancel to Cancel New User.
Edit User

Because of changing situations, you may find that you need to edit an Eris System User.  An example of this would be changing a person’s last name when they get married.  To edit the User Information follow this procedure:
1. Go to Tools menu

2. Click on Security

3. Select the User you want to open 

4. Click on Users 

5. Click on Open Selected User
You can also combine Steps 3 thru 5 by just Double Clicking on the User you wish to edit.

Set User Password

The Eris System allows administrator or other personnel that the administrator gives Security Access to change password.  The Password usually has to be reset when the User forgets their Password.  Eris provides a quick and easy method to facilitate this issue as shown below.
1. Go to Tools menu
2. Click the user you want to change
3. Click on Change Password or right click on the selected user.
4. Enter Current Password

5. Enter New Password 

6. Confirm Password 

7. Click on Ok to set New Password

8. Click on Cancel to cancel change password
For Administrators, who should be changing their password more regularly than End Users, a Change Password Menu Items has been added to the Tools Menu to make this process more streamlined.

As mentioned earlier, Groups allow you to simplify your management tasks.  Groups allow you to add individual Users to a Group.  Then you can just administer that Group instead of have to find all the Security Items that an individual User has been assigned.  This will happen as personnel are reassigned to different projects, different departments or leave the company.
Add Group
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1. Go to Tools menu
2. Click on Security

3. Click on Groups

4. Click on Add Group

5. Enter Group Name and Description.

6. To add a User to the Group, Click on the User you wish to add and Click the “>” Button to add the selected User to the Group

7. To add all Users to the Group, Click the “>>” Button to move the Users to the Members Listbox.

8. To remove a User from the Group, click on the User in the Members Listbox and Click the “<” Button to remove them.
9. To remove all Users from the Group, Click the “<<” Button to move the Users to the Employee Listbox.

10. Click on Save

11. Click on Cancel to cancel the New Group.

Delete Group

1. Go to Tools menu

2. Click on Security

3. Select the group which is to be deleted

4. Click on  Groups

5. Click on Delete Group.
Security

Now that we have created the Groups and Users for the Eris Data and Documentation Management System, we can configure the Security Settings for the various Security Items.

There are three levels of Security Access for each Security Item in the Eris System.  They include the following:

Users and/or Group having Full Control Permission on Security Item can have access to read, write, modify and delete items.

Users and/or Group having Change Permission on Security Item can have access to read, write and modify items.  These Users cannot delete items.
Users and/or Group having Read Only Permission on Security Item can have access to read only items.  These Users cannot change or delete items.
Default has no access.  If the user has No Access to Security Items the data or files are not available to them at all.
To modify Security settings:

1. Go  to Tools Menu

2. Click on Security

3. Again Click on Security 

4. Select Module Security

Assigning Permission to Client – Project Management nodes
In the Security Items Treeview, the Client – Project Management Node has three child nodes.  They are 

· Client

· Project

· Contact

All users of the Eris System need to have at least Read Only access to these nodes or the application cannot be used properly.  The No Access Security Setting is provided to remove a user’s access, say during the day an employee is terminated.  This will lock them out of the system.  This can be done quickly and safely by the administrator without the possibility of losing any data or files.

These nodes allow you to finely control who can create, edit, view or delete Client, Project and Contact information.  The information concerning the Clients / Projects / Contacts is located on the Tabs on the top half of the Main Form.

Permission can be assigned to each member (a Group or a User). For assigning Read Only permission, drag the selected member (Group/User) and drop it into Read Only box. Similarly, for assigning other permission (Change and Full Control) drag the selected member (Group/User) and drop it into appropriate permission box.
Repeat the process for assigning Permission to Project and Contact

Assigning Permission to Information Center nodes
The Security Items under the Information Center Node controls the access to the information and files on each of the Tabs in the lower half of the Main Form.  This ability allows the administrator to determine which user has access to which Tab and if they can create, edit, view or delete information and files stored in each of these Tabs.

Information Center Security item handles the Security issue of File Management System. File Management System handles Create New File, Open Selected Item, Add Existing File and Delete Selected Files and perform Clipboard Actions. Information Center allows whoever is involved in a particular project to be able to find all the information related to that project. Thus allowing multiple users to manage and have access to all of the files that they work on a daily basis.  To assign Security Items follow the procedure below.
1. Select Node

2. For assigning group permission Read only – Drag the Selected Groups and / or Users and drop them into Read only box.

3. For assigning group permission Change – Drag  the Selected Groups and / or Users and drop them into Change box

4. For assigning group permission Full Control – Drag  the Selected Groups and / or Users and drop them into Full Control  box

Repeat the Process for each Node.

Assigning Permission to Security Item nodes
The Security Node is for Administrative Purposes Only.  The Admin User automatically has access to these tasks.  But some of these tasks could be delegated to other individuals.  This will distribute the burden of administration over several users, but still maintain tight control of the administrative tasks associated with the Eris System.  It also minimizes the number of users with full administrative capabilities.  To assign Security Items follow the procedure below:

1. Select Node 
2. For assigning group permission Read only – Drag the Selected Groups and / or Users and drop them into Read only box.

3. For assigning group permission Change – Drag  the Selected Groups and / or Users and drop them  into Change box

4. For assigning group permission Full Control – Drag  the Selected Groups and / or Users and drop them into Full Control  box

Repeat the Process for each Node.
General Usage Procedures

Client Management
Client and Project Management is the heart of the Eris System.  Not only are they used to maintain the data for each Client and Project.  They are also used as filters to quickly access documents associated with a Project.  When you select a Client from the General Tab, only the Projects for that Client are displayed.  Both the Client drop down and the Project Data Grid can further be filtered by selecting specific Client and Project Status values.

These filtering methods are also available on the Client and Project Tabs.
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New Client
To create a new Client use the following procedure:
1. Select  Client Tab

2. Click on New Button

3. Enter Client Information

4. Click on Save Button to save Client. Click on Cancel Button to cancel creating New Client.

Edit Client
To edit an existing Client follow this procedure:
1. Select the Client

2. Click on Edit Button
3. Edit the Client Information
4. Click on Save Button to Save changes or Click the Cancel Button to discard the changes to the selected client.

Delete Client
You can delete a Client from the Eris System, but it should be done with care.  Also the Security Access for deleting a Client should be very limited.  The reason for this is that by deleting a Client you will also delete all the Project, Contact and Project Files that are associated with the Client.  So be very careful when doing this operation.  To delete an existing Client use the procedure below:
1. Select the Client

2. Click on Delete

Contact Management
Contact Management allows compilation of a large number of different ways to contact an employee of a Client.  It provides the ability to collect all the contact information not only for the Contact’s work information, but also their home contact information.  These Contacts are filtered on a Project by Project basis via the Project Contacts on the Project Tab.
New Client Contacts
To create a New Client Contact use the following procedure:
1. Select Client

2. Click on New Button in the Contact Group Box on the left side of the Client Tab
3. Enter Contact  Information 

4. Click on Save Button to Save Contact or Click on Cancel Button to discard the Contact Information
Edit Contact
To edit an existing Client Contact use the following procedure:
1. Select the Contact 

2. Click on Edit Button in the Contact Group Box on the left side of the Client Tab
3. Edit Contact Information
4. Click on Save Button to Save Contact or Click on Cancel Button to discard the changes to the  Contact Information
Project Management
The Project Tab is used to manage information that is specific to the Project.  It allows the User to quickly find the Project Number for billing purposes, the major Project Team members and Client Contacts that are associated with the Project.
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New Project
To create a New Project use the following procedure:
1. Select Client either on the General Tab or the Client Tab
2. Click on Project Tab

3. Click on New Button

4. Enter Project Information

5. Click on Save Button to save the Project Information or Click the Cancel Button to discard the New Project.
Add Project Client Contacts to Specific Project
If you have added Client Contacts as described earlier in this manual, you can add them as Project specific Contacts as well.  To add existing Client Contacts to a Project use the following procedure:
1. After creating Project, Select the Project in which you want to add Project Client Contacts.

2. Click on Edit button of Project Client Contacts.

3. To add new contact Click on New Button 

4. Add contacts 

5. To make Primary Contact Click on Make Primary Button

6. Click Ok to save and Click Cancel to discard the Contact from the Project
Edit Project

1. Select the Project on the Project Tab
2. Click on Edit Button

3. Make changes to the Project Information
4. Click on Save Button to save the changes or Click the Cancel Button to discard the changes
Edit Project Personnel
You also have the ability to assign your own employees to three (3) major positions that are important to the project.  These positions are

· Project Manager

· Product Manager

· Salesperson

It is not mandatory that these positions have people assigned to them.  But by listing the employees, other employees working on the Project can quickly figure out who they need to contact when questions arise.

To edit the Project Personnel use the following procedure:
1. For each Project Personnel, Click on Edit Button

2. Cick the “>” Button to add the person or Click the “<” Button to remove the person from  Project Personnel

3. To make Primary Project Personnel, Click on Make Primary Button

4. Click Ok Button to save the changes or Click the Cancel Button to discard the changes
Delete Project 

You can delete a Project from the Eris System, but it should be done with care.  Also the Security Access for deleting a Project should be very limited.  The reason for this is that by deleting a Project you will also delete all the Project Contacts and Project Files that are associated with the Project.  So be very careful when doing this operation.  To delete an existing Project use the procedure below:
1. Select the Project you want to delete

2. Click on Delete Button 
View Bookmarked Project
Bookmarking a Project allows the User to create a list of Project that is specific to that User that they work on frequently.  This is the fast lane to get to Projects that the User is currently assigned.
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To use the Bookmarked Project Tab use the following procedure:

1. Click on Bookmarked Projects Tab
2. Click on a Project in the Project List

When you click on a Project, the Information Tabs in the lower half of the Main Form will display the files and other information that pertains to the selected Project.
Add Bookmark
To add a Project to the Bookmarked Project Tab use the following procedure:
1. Select Project on the Project Tab
2. Click on Add Bookmark Button on the Main Form Toolbar
Once this has been done the Project will appear in the Project Data Grid on the Bookmarked Projects Tab.
Delete Bookmark
To delete a Bookmarked Project use the following procedure
1. Select Bookmarked Project from the list of Projects on the Bookmarked Projects Tab
2. Click on Delete Bookmark
View Recent Project
The Recent Projects Tab in the top half of the Main Form is also a time saver to allow the User to quickly review and access the most recently viewed Projects.  It works like the Recent Files commands on all the Microsoft Office applications, except it works on all the documents associated with a Project instead of just the files themselves.  The number of Recent Projects can be set by Clicking Tools -> Options Menu.  Then adjust the number of Recent Projects to display.
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1. Click on Recent Projects Tab
2. Click on the desired Project in the Recent Project List

When you click on a Project on the Recent Projects Tab, the Project Information in the Project Tab in the top half of the Main Form and the Information Tabs in the lower half of the Main Form all display information associated with that Project.
Simple Search
For those times when you need to search for Projects that have similar data associated with them that would be difficult to find any other way, the Simple Search Tab in the top half of the Main Form is your answer.  It can return lists of Projects based on some of these criteria listed below:
· All Projects that fall within range of Project Numbers, regardless of Client

· All Projects associated with a specific Client Contact

· All Projects with a Project Status of Active

· All Projects with Project Names containing the word “Manufacturing”

The search criteria can also use multiple search items, so you can further filter Project as shown below:

· All Projects for Client “XYZ Corporation” that have an “Active” Project Status and are associated with a Client Contact “Tom Jones”

· All Projects for all Clients that have a Client Status of “Active” and a Project Status of “Completed”

This list could go on and on, but this gives you an idea of what can be done with searches.
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Simple search can be performed by any combination of search items. Search by,

Client

Client status

Project Number

Project Name

Quote Number

Project Status

Contact Name

To use the Simple Search Tab use the following procedure

1. Enter the Search item 
2. Click on Search Button to display the results of the Search
The Clear Button is used to clear all the Search Criteria Items for preparation of a new Search.

Information and File Management Tabs

If the Client and Project Management is the heart of the Eris System, then the Information and File Management Tabs are the muscle.  These Tabs do the heavy lifting of managing all the Communications, Emails, Appointments, and Files associated with a Project.  They allow the Users to manage all the information for a Project in one location.  Below you will see a breakdown of each of the Tabs.
Communication Tab
The Communications Tab is used to log the following types of Communications.
· Incoming Phone Calls

· Outgoing Phone Calls

· Incoming Postal Delivered Mail

· Other User Defined Communications

The Communications on this Tab log the Date and Time the Communication occurred, the Contact associated with the Communications, the Type of Communication, and Notes concerning the Communication.
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A new Communication is initiated by using the following procedure:
1. Click on the New Communications Command in the Communications Tab

2. Select the Type of Communication from the Drop Down List that contains Incoming Call, Outgoing Call, Letter and Other

3. Edit the Date and Time if they occurred in the past and you are just now adding them.  The Current Date and Time are automatically placed on the form.

4. Enter the name of the Contact, whether they are from the Client, a Vendor or other person associated with the project.

5. Add Notes describing what was discussed or included in the Postal Delivered Mail
6. Click the Save Button to Save the Communication or Click the Cancel Button to discard the information.
Email & Appointments Tab
The Email and Appointments Tab is used to manage any Emails and Appointments associated with a Project.  When Emails and Appoints are created in the Eris System, they are automatically added to your Microsoft Outlook Inbox, Outbox or Calendar locations.  The beauty of this system is that all emails can be seen by all the Project Personnel who have security access to view them.  The Project Group no longer has to be asked why an individual was not copied in an email and can you send me a copy.  Or the most embarrassing issue is to have the Client call up asking about something that they emailed to a Project Member and they are not in the office, so the email cannot be reviewed by others on the Team.  In addition, the Team members cannot say that they did not receive an email because they deleted it propos fully or accidentally, since there in now a log of when they received the email.
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Send an Email

To Send an Email from the Eris System use the following procedure:
1. Click the Send Email Command in the Email and Appointments Tab

2. Fill out the New Email Message Form just as you would a new Microsoft Outlook Email

3. Click the Send Button to send the Email or Click the Cancel Button to discard the Email.

In addition to adding standard attachment, it is possible to add Project based Attachments.  By clicking the Project Attachments Button, a dialog box is displayed that shows all the Document Tabs and their associated folders to allow you to select any file that you have security access to view or edit.  If you have created a signature in Microsoft Outlook, it will automatically appear in the New Email Message Form.
Create an Appointment

To Create an Appointment from the Eris System follow the procedure below, if you have security access to create files:
1. Click the Create Appointment Command in the Email and Appointments Tab

2. Click the To Button to select all the people that need to attend the Meeting

3. Enter a Subject, Location, Start and End Dates / Times, and Comments just as you would in Microsoft Outlook

4. Click the Send Button to Save the Appointment or Click the Cancel Button to discard the Appointment.

Open Selected Item

If you have the security access to view or edit Email and Appointment Items, you can Open a Selected Email or Appointment for review or to edit using the following procedure:

1. Click the Email or Appointment that you wish to open

2. Click the Open Selected Item Command in the Email and Appointments Tab

Another way to open the item is to Double Click the Email or Appointment.
Delete Selected Item

If you have the security access to delete items on the Email and Appointments Tab, you can delete a selected item by using the following procedure:

1. Click the Email or Appointment that you wish to delete

2. Click the Delete Selected Item Command on the Email and Appointments Tab
Document Tabs
The last six (6) Tabs are used to store files.  There are no restrictions as to what types of files you wish to store in each Document Tab.  It is possible to change the names of the Document Tabs to closely meet the needs of your company.  The thing to remember about the Document Tab Names is that they will be the same for all Projects in the Eris System.  You cannot have different Document Tab Names for different types of Projects.  The Document Tab Names can be changed on the Document Tab Names Tab of the Administrator Options Dialog Box that is accessible from the Tools Menu.
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Each File added to the Eris System contains metadata that includes Filename, Date the File was created, File Status (Ok for available or checked out when someone else is editing the file), the Last Person to access the File and File Notes.  In addition, historical information for each File is also stored for each File.  The historical data shows the File Status, when the File was Checked Out, when the File was Checked In and the Employee who was using the File.  This makes it easy to find out who did what to a File and when it was done.
Create New File
The Eris System allows the User to create Microsoft Office Files directly from the Eris Main Form.  This allows them to automatically create the file within the Eris repository as the file is first created.
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If you have security access to create a New File use the following procedure:

1. Click on one of the Document Tabs to select where the File will be created.
2. Click on Create New File Command on the Document Tab
3. Click of MS Word, MS Excel or MS PowerPoint to create the appropriate File Type
4. Enter the filename for the File

5. Click the Ok Button to Create and Save the File or Click the Cancel Button to discard the File

Open Selected Item

The Eris System allows Users who have security access to open files that have been created or added to the Eris repository.  Any File with a file extension that has been assigned to an application can be opened from within Eris.
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If you have security access to Open Existing Files use the procedure below:

1. Click on the Document Tab that contains the file you wish to open

2. Click on the File you wish to open

3. Click on the Open Selected Item Command on the Document Tab

The file will then be opened in the applications associated with that file.  If you look back at the Eris Main Form, you will see that the Status has changed from Ok to In Use and show the person on the Team who has it open.  In the historical data section below the list of Files, you will see that Status will be In Use as of the current date and time of the Check Out and that you have the File open.

Another way to open an existing File is to Double Click on the File.  This is a faster and easier method of open the File.
Add Existing File
The Eris System has the ability to add Files that have not been created through the Eris Interface to be added to an Eris Project File Repository.  This allows for the addition of older data that was created prior to the use of the system or files that were created when Eris is not available.  An example of this would be doing work at home and bringing it back to work the next day.
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If you have security access to add Files to a Project, use the following procedure:

1. Select the Project you wish to add the existing File

2. Click the Document Tab in which you want to add the existing File

3. Click the Add Existing File Command on the Document Tab

4. A standard Add/Open File Dialog box is displayed.  Use it to navigate to and select the desired File

5. Click the Ok Button to add the File or Click the Cancel Button to abort the addition of the File

You can also Drag and Drop a File from My Computer, Windows Explorer or even your Desktop onto the desired Document Tab in the appropriate Project to also add an existing File to the Eris System Repository.
Delete Selected Item
The Eris System allows Users who have appropriate security access to delete a File from the system.  To delete a File use the following procedure:
1. Select the Project you wish to delete the File

2. Click the Document Tab in which you want to delete the File

3. Click the File or Files which you want to delete

4. Click the Delete Selected Files Command on the Document Tab

5. Click the Yes Button on the Dialog Box to delete the File or Click the No Button to abort the delete
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